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CHAPTER 1
Introduction to Windows

Operating Systems

Operating system is like a manager of an e Monitor
organization. It manages the overall
functions of a computer in a systematic | I
manner. It is system software that Yo

controls and coordinates the hardware  Hard brive

Printer
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devices of the computer and runs other = °sys'f:,',',‘9
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software and  applications on a : .. Mouse
computer. Keyboa,d ~—

The main functions of an operating »

system are booting the computer, managing system resources (CPU,
memory, storage devices, printer, etc.), managing files, handling input and
output, executing and providing services for application software, etc.

Examples of operating system: Microsoft Windows, Apple iOS, Android OS,
MacOS, Linux, etc.

Windows Operating Systems

The first GUI package Windows 1.0 was
introduced in 1985 by Microsoft Inc. and then
the first windows based operating system
called Windows 95 was introduced on 15th
August 1995. Windows evolved as different
versions over the years by incorporating ‘
various changes based on the technology Biil Gétes
developments and research. Windows11 is the The Founder of Microsoft and
latest OS version from Microsoft which was | one of the richest mar in the world
introduced on Stk October 2021. For the sake
of availability of software, let us use Windows 10 operating system for
learning purpose. Windows 10 combines the features from its previous
versions for making it further user friendly for desktops as well as laptops
and mobile devices. Some of the features are:

» It is a Graphical User Interface (GUI).

» It has a new style of Start menu.

» It allows you to run several programs at the same
time.

Windows 10
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» It supports for higher speed of operation. The process of booting and
shut down is simplified and takes very less time.

» It supports for enhanced gaming experience

» User can interact with a computer using voice assistant Crotana, a
special feature provided in Windows 10.

The process of loading an operating system into memory is called booting.

C'omponents of Windows 10

Start the computer by pressing the power button and then the process of
booting will begin. It means preparing the computer ready for working with
applications and utilities through various devices.

NOTIFICATION
AREA

Window is a rectangular box that contains three buttons in the upper-right
corner. These are used to minimize, maximize or close the window

» Minimizing means that the window will hide in
the Taskbar.

» Maximizing will bring the window to a full-screen
size.

» Close button closes the application.
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Desktop components

Desktop Background/Wallpaper

After the booting process,
Windows 10 displays the main
screen area called desktop. This
is like an index of the windows
operating system at one place. It
can be organized for the
convenient of users. There are
three major components in
desktop. They are

» Icons
» Taskbar
» Desktop background

Icons

An icon is a small picture that represents applications,
programs, folders or a file. By double clicking on an icon,
the corresponding application or software will be opened.
Right clicking on an icon displays various properties
associated with an icon. The purpose of some of the
important icons present on desktop is given below

Name of the Icon Purpose
icon
By opening this icon, it displays all the
This PC available hard disk drives such as C, D, E etc
and other drives for Pen Drive, CD/DVD,
important folders etc.
Network It contains the shared files or devices of the
different computers on the network.
It is like a dustbin in house. This folder
contains all the deleted files. Those files can be
Recycle .
Bin deleted permanently or restored by choosing
Recycle Bin the appropriate options on right clicking the
file(s).
Application It represents application software called MS-
PP Excel. On double-clicking this icon it opens the
Icons
- Ntht Excel software.
VIICTOSOTL...
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The shortcut icon is like a dummy icon
IB because it is only the reference to the

Shortcuts concerned file, folder or application. A small
NEEE | jump arrow symbol at the bottom left corner of
an icon indicates shortcut icons.
Taskbar

The most important component of the desktop is the Taskbar. By default,
it is present at the bottom of the screen. It contains

» The Start menu - It shows two panels, side by side for accessing the
various applications in different ways.

» Search Box — It helps to browse through computer and web

» Opened programs or frequently used applications

» The Notification Area — It shows the status and notifications about the
running programs, clock and other icons etc.

‘I, 1‘ 2 — 1 = = E @ r\‘—‘\.g_ 2 B O ‘:: L]
— Saarch I[: (Middle Section) !Jpenad Program {_ A Notification
Bo! L L L
Button Area

Desktop Background

It is an image that appears at the back of your screen. Most computers
come with a pre-selected background, but you can change it to any image
you want.

To change the background, follow these &) Graphics Options
steps New

. . [0 Display settings
Step 1 - Right click on the desktop and o Personalize

choose “Personalize”.

Step 2 - From the Personalization window, choose from the available
pictures or browse for your own.

After choosing a picture, the Background will change automatically.
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Preview

Choose a fit

cture
(hoose your pcture
Bowse

Browse for your
own picture

You can make system settings by right clicking on the desktop and choose
“Display Settings”. The options like Power & Sleep for setting the time
limits for sleep mode and to turn off the screen and the option Storage can
be used to see the capacities of each drive in hard disk and to assign the
default locations for saving different types of files.

File Explorer or Windows explorer

» The Navigation Pane provides quick links to various folders and

locations on your computer.

» The Title Bar contains no text although it still provides the method for

moving the folder.

» My Documents contains

most of your wuser
documents and files
(except for music,

pictures and videos).
» The Address Bar has a

bread crumb menu.

Clicking on any of the
listed

items  Clicking

behind the address transforms it into the complete path

e e Ko
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Navigation Pane Scroll Bar Files/Folders List Details Pane
like

C:\Users\Admin\Desktop\AEES Computer Education - Home Desktop

» Clicking on Pictures would take you back to the Pictures folder.
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» Clicking on Russ would take you to the folder shown in the diagram

above.

Files and Folders

Folder (or directory) — a virtual storage space used to store and organize
computer files.

» A folder can also contain additional folders (subfolder — a folder
within another folder).
» A folder has a name and is represented by an icon.

File — a storage unit on a computer that stores information or data (such
as a document, an image, etc.).

» Folders contain files.
» Files are represented by names and icons.

Filename -A file name is used to identify the file uniquely. It can contain
letters, symbols, numbers, spaces, etc. The extension of the file associates
the type of the file. For example the file name hoviya.docx has the
extension as docx which is a word document.

Windows accessories

Accessing accessories: click the start menu then choose all apps, then
navigate alphabetically to Windows Accessories as shown in the picture.

B Westher

- Wimrdrsse T LICE PAAD Dissaimln

.' Windows Accessories

Microsoft Edge

mmr . LAFACIEr Map

Windows accessories have the following programs inside it:

. . % Character Map - X

1- Character Map: list of all possible |,
. . . " $ (% g =+ _
special characters with different font | [fFESEr [T ] Iolz00
styles to assist you in typing. For | bt iine
. . q|r|s|tlu|lviw|x|y|lz|{|]|}~ [ ¢[E|n|¥
example mathematical formulas, smiles | s [o <& [z [s1 .|"
. . o [l ALK K AL EIE EIE T
and emoji’s you will not find on your | [ 20908002000 uwns s
keyboard o|=leulalalaly|[p|v|AlalAla[Ala[C[e|C[e
: Characters to copy : l Select Cop
[Jadvanced view
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2- Internet Explorer: the well-known
Microsoft built in web browser used *
to surf the internet, which is
replaced now by Microsoft Edge.

3- Mathematical input panel: a new
feature with Windows 10 that
allows you to manually input
mathematical formula using free
handwriting, instead of spending time searching for symbols in
character map.

Erase
Select and Correct

Y 2R B
210 | <

Undo | Redo | Clear

4- Notepad: the world’s most Dt - D X
famous text editor comes in a
very handy interface when it
comes to text editing.

5- Paint: the well-known
Microsoft Paint, a simple
editor for pictures.

i = | Usstivied - B
O 2o e gl Svogosa mEmEs wEE
reme swea DO e e e 5SS .

..?.
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Control panel

To start Control panel in Windows 10, click the Start button or press the
Windows key, type “Control Panel” in the search box in the Start menu,
and press Enter. Windows will search for and open the Control Panel
application. You can also select the control panel by pressing Start Button
- Right click>Choose the Control panel. It shows the various utilities
available under control panel to change the settings for Windows 10. We
can customize the features of hardware and software available in the
computer.

[E2 All Control Panel ltems -
4 [ s Control Panel > All Control Panel tems. «|® | Search Control Panel r
Adjust your computer’s settings Viewby: Large icons ¥
Administrative Tools Adobe Gamma (32-bit) AutoPlay ‘a% gzi::zj{:i?esmre % BitLocker Drive Encryption
‘ = -
E Color Management g‘ Credential Manager “L Date and Time @ Default Programs ,é! Device Manager
,_g_p_:'l Devices and Printers D Display E@] Ease of Access Center EJ File Explorer Options g File History
Flash Player (32-bit) A Fonts " HomeGroup ;.), Indexing Options m L‘::;IEER) Graphics and
Internet Options é_, Java (32-bit) <> Keyboard %@‘ Language A Mail (32-bity
_? Mouse :ll: ?::Ntet:rk and Sharing E Personalization g Phone and Modem \{Q Power Options
I P : . RemoteApp and Desktop . . .
Ly Programs and Features ‘J;:! Recovery f_@ Region E&;‘) Connections "ﬁ Security and Maintenance
'\:\W Sound 67 Speech Recognition g Storage Spaces @ Sync Center [5? System
E' Taskbar and Navigation Troubleshooting S& User Accounts g{&[ Windows Defender ﬂ Windows Firewall

g Work Folders

Desktop Screen Saver

A screen saver program in windows
helps to set a text message or image
when the computer goes to idle state
after a period of user inactivity. It also
helps to prevent the computer by
setting password for screen saver while

\

Screen saver

the user goes away for a short period.
The steps to be followed for changing
the screen saver is as follows

Bubbles v Settings... Preview

Wait: 5% minutes [] On resume, display logon screen

Click on Start Button—>Settings—>Personalization->Lock screen, and
select Screen saver settings. In the Screen Saver Settings window, choose a
screen saver from the drop-down list.
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EXERCISE

A. Multiple Choice Questions

1. A/An is the small picture that is used to open a program.
a. Taskbar b. Icon c. View d. Windows

1. Which of the following is not an operating system?

a. UNIX b. Windows 10 c¢. WordPad d. Android
2. Windows is developed by Corporation.
a. Pentium b. Microsoft c. Parle d. IBM
3. is the process of loading an operating system into the
computer’s memory.
a. Starting b. Booting c. Executing d. log in

4. You can change the position of the .
a. Start Button b. Taskbar c. Title Bar d. None

5. An operating system is a
a. hardware b. software c. firmware c. All of these

6. Who is the founder of Android operating system?
a. Andrew E. Rubin b. Steve Jobs  c. Bill Gates d. Sundar

7. Which of the following is used to see the shared files or devices of the
different computers on the network?

a. Network b. Recycle Bin c. Computer d. this PC
8. is a browser to work with websites
a. Internet explorer b. Windows c. Python d. Basic

B. Fill in the blanks

Start Button / Note pad / Manager / Auto Arrange Icons/Taskbar

1. Operating system is the overall of the computer system.
2. Computer can arrange the icons itself if the
option is selected.

w

is present on the extreme left of the taskbar.
4. A long horizontal bar at the bottom of the Desktop is called

S. is a text editor comes in a very handy interface

when it comes to text editing.
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C. Answer the following

1. What is Desktop background?

2. What does GUI stand for?

3. What are icons?

4. What is an operating system?

5. Define a file?

6. What is the use of Recycle Bin?

7. Name any four important utilities in Control Panel.
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CHAPTER 2

History of Computer

Introduction

The ancient people used various methods for counting like stones, pebbles,
sticks, fingers, toes etc. These methods are not suitable for the complex
and bigger problems, hence the need for advanced machines arise in
computations. The computers we use today are very advanced and much
different from the early devices that were invented for doing calculations.

Let us learn about some of the early calculating devices.

Early Calculating Devices

Abacus

The Chinese invented a calculating machine called —
Abacus for simple calculations like addition and '-.w.m“—‘_ =
subtraction about 5000 years ago. The old Abacus :%‘m~~~~-~~»e

used stones but nowadays it made up of strings and i
beads. B

Napier’s bones

In 1617, John Napier, a Scottish mathematician
invented a calculating device called Napier’s bones. It
has got rectangular rods written with numbers. It
can perform addition, subtraction and
multiplication. The upgraded version was capable of
doing division and square root.

alalee=] o

Pascal’s Adding Machine (Pascaline)

In 1642, Blaise Pascal, a French mathematician
invented the Pascal’s Adding Machine. It was
having moveable gears with a box for addition,
subtraction, multiplication and division. Pascal
invented this machine at the age of 18, to assist
his father in calculations for the tax collected.
The same concept is still being used in odometer,
speedometer etc.
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Leibniz Calculator

s S-SelodeSe it Gottfried Leibniz, a German Mathematician
o ; invented the calculating device Leibniz Calculator.
It performed arithmetic calculations like addition,
subtraction, multiplication and division. It was
made up of a stepped drum connected to a
counting wheel and teeth.

Charles Babbage’s Difference Engine

In 1822, Charles Babbage, mathematics professor of
Cambridge University, England, designed a machine
called Difference Engine which could do calculations
automatically. It was operated manually.

Analytical Engine

In 1833, Charles Babbage dropped the development
of difference engine and started creating a modern
machine called Analytical Engine. The analytical
engine had an input, output and processing system
as in modern computers. Therefore, Charles
Babbage is called as the father of the computer.

Electronic computing devices
ENIAC (Electronic Numerical Integrator and Computer)

John W. Mauchly and J.Presper Eckert
invented the first electronic digital computer
ENIAC during the year 1946. It was a gigantic
size with 100 feet long, 10 feet wide, occupied
1800 square feet and consumed about 1,80,000
watts of electrical power. It was capable of

performing 5000 additions per second.

UNIVAC 1 (UNIVersal Automatic Computer)

In 1951, the developers of ENIAC had developed another computer
called UNIVAC-1 and that was the first general-purpose electronic
computer which could handle both numeric and textual information.
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Generation of Computers

The generation of computers means the advancement and growth of
technology in certain period of time. It can also be defined as “the
evolution of computers to the current stage”. The growth of computers
in five different phases are denoted as five generations of computer

based on the period, speed, size and computing element.

Generation | Period Component | Characteristics Example
First 1946-58 | Vacuum Huge in size, small ENIAC
tubes memory, slow speed. UNIVAC 1
High power
-%.—. 2 consumption.
T Use of machine
language.
Second 1959-64 | Transistors Small in size, fast and | IBM 1401
’ cheap. RAMAC
More storage capacity
and more powerful
-=—__— operating system.
Assembly language
programming.
Third 1965-71 | Integrated Small in size, less IBM 360
Circuits (ICs) | power consumption. series
Semiconduct | Billions of instructions | ICL 1900
or chips in a few seconds.
uses LSI
technology Increased storage
(Large Scale | capacity.
Integrated)
m Less heat generation
i ol
— Used Computer
languages COBOL and
FORTRAN
Fourth 1971- Microproces | Greater computing IBM - PC
Present | sors power. Intel 4004
IBM 370
Uses VLSI Large storage capacity.
technology
(Very Large | Unique storage devices
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Scale at less cost

Fifth

Integrated
%, Programming
languages C, C++,
Java etc.
Present- | Artificial Very high speed, huge | Super
Beyond | Intelligence, | storage capacity. computer
Nanotechnol
ogy Voice recognition. Robot

Large memory
requirements.

More user-friendly

Classification of Computers

Computers perform different types of tasks depending upon its ability,
speed and size. Computers can be classified based on the size, purpose,
working principle etc.,

Classification of computers according to the purpose

There are three types of computers based on the computational method or
purpose. They are

1. Analog Computer
It works on the principle of continuous values such as voltages,
pressure, distance, position etc. Some of the examples for analog

computers are thermometer, voltmeter, speedometer, scale machine

etc.

Thermometer Speedometer Scale machine
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2. Digital Computer
These computers operate on discrete data. It represents data using
binary numbers such as O and 1. Some of the examples for digital
computers are micro-computer, desktop, laptop, calculator, mobile
phone etc.

3. Hybrid Computer
The computer that has the features of both |
analog and digital computers are termed as
Hybrid computers. It is a cost effective method
to perform the complex tasks. Some of the
examples  are Electrocardiogram (ECG)
Machine, Ultra Sound Machine, Nuclear
security systems, control system for flights etc.

Classification of computer based on its size

There are four classifications based the size and power of the computers.
They are as follows

» Micro Computer

» Mini Computer

» Mainframe Computer
» Super Computer

Micro Computer

Micro Computers are the smallest, most affordable and most reliable. Micro
Computer is a computer that has a microprocessor chip as its CPU.It is
also called as Personal Computer. It includes (i) Portable computers and(ii)
Desktop computers.

(i) Portable Computer

Portable computer is a very small, easy to use microcomputer. It can be
carried easily from one place to another. It includes personal digital
assistant (PDA), note book computer and laptop.

(ii) Personal Computer or Desktop Computer

The Personal computer is a microprocessor based,
single user computer. It can be placed easily on the
desk hence it is called as desktop computer.
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Mini Computer

It is a multiuser computer that comes
with lesser memory and storage. It is
also called as workstations. A
Minicomputer is a medium sized
computer developed in 1960s. It is
mostly used in universities, colleges
and industries.

Mainframe Computer

A mainframe computer is a
large, powerful computer that
handles the processing for
many users simultaneously.
The mainframe computers have
large storage -capacities, very
high speed of processing. They
are kept in air-conditioned
environment.

Applications: They are used by
big companies, banks,
government departments, etc.,

SUPERCOMPUTER Supercomputer

It is the largest, fastest and most
expensive = computer. The  storage
capacity and computing speeds are
much higher than any other computer.
It can perform hundreds of millions of
instructions per second.

Applications: These computers are used in military simulation,
engineering, weather forecasting, medicine and nuclear energy research
etc.
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EXERCISE

A. Multiple Choice Questions

1. Who invented Abacus?
a. Chinese b. India c. USA d. Japan

2. Who invented Difference Engine?
a. John Napier b. Gottfried Leibniz
c. Charles Babbage d. Blaise Pascal

3. What is the full form of ENIAC?
a. Electronic Numerical Integrator and Calculator
b. Electronic Numerical Integrator and Computer
c. Electric Numerator Integrated Accounting Computer
d. Electric Number Integrated Accounting Calculator

4. What was the component used in second generation computer?
a. Vacuum Tubes b. IC c. Transistors d. VLSI

5. Which of the following is an example for analog computer?
a. Desktop b. Speedometer c. Smart Phone d. Laptop

6. Which of the given computers is handy and it can be operated with

the touch of the fingers?
a. Tablets b. LAN c. Mainframe d. Desktop

B. Fill in the blanks

Super Computer / 1833 / Digital / Charles Babbage /IBM 360

1. is called as father of computers.

2. Analytical Engine was invented in the year

3. is an example for third generation of computers.
4. computers operate on discrete data.

S. The largest, fastest and most expensive computer is

C. Answer the following

1. What do you mean by Difference Engine?
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. Write a short note on ENIAC?

. Name the components used in first four generations?

. Differentiate between analog and digital computers?

. What are the classifications of computers based on its size?

. What do you mean by desktop computers?

. What are the applications of super computers?
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CHPATER 3

Multimedia

Introduction

Multimedia is a method of communication, to present the information in an
attractive manner using text, graphics, images, audio, animations or video
in an integrated manner.

Multimedia plays an important role in the presentation. It can be used in a
variety of applications such as entertainment, advertisement, education
etc. The evolution of internet has also increased the demand for multimedia
content.

Definition of Multimedia

Multimedia is the way to represent computer information in an attractive
manner using text, audio, graphics, animation, video etc. It also refers to
the use of electronic media to store and experience the multimedia content.

Multimedia System

The computer system capable of processing, storing and manipulation of
multimedia content using multimedia components and applications are
termed as multimedia systems

Components of Multimedia Systems

In order to present the content in an attractive and interactive manner, the
following components may be used.

a. Monitor
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Colour monitor with high resolutions help to present the content in a better
way. It is also preferred to use 19” or higher size monitors for animations,
images, video or presentations.

b. CD-ROM/DVD Drive

It is used to store/play the contents on the computer and it is common
that multimedia contents occupy more storage space because of various
components of multimedia are included.

c. Speakers and Sound Card

The sound and audio effects can be heard through speakers and the sound
card is necessary to recognize the speakers connected through the ports.

d. Microphone and Headphone

A microphone is a small device used to record sound or voice into the
computer. The headphones are used to hear the sound, voice, songs etc. A
headphone with microphone is used to record as well as hear the sound.

e. Joystick

It is an input device, used to play games on a computer. It has got one or
more push buttons to control the operations of the game or software and it
can also be read by the computer.

The various components of multimedia are Text, Audio, Graphics, Video
and Animation. All these components work together to represent
information in an effective and easy manner.

Applications of Multimedia

Multimedia is an amazing modern technology for the entertainment and
learning. It provides enormous advantages in various fields of
communication, advertisement, Medicare etc. Some of the applications are
given below

s In the field of Education, it has brought a tremendous change to
supplement the teachers and students. The various multimedia
software help to learn the subject in the self-paced manner sitting at
home.

% Entertainment: Multimedia has witnessed tremendous growth in the
field of entertainment like TV, Social websites (YouTube, Facebook
etc.), Movies etc.

% Marketing: It helps to create advertisements to promote the sales in
marketing

% Communication: It is possible to have video conference, conference
call and live video streaming etc.

v Mass Media - It is used by the journalists for preparing magazines

and newspapers.
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% Gaming Industry - Video Gaming is an exciting application of
multimedia.

% Medical field - Multimedia is also used by the surgeons as they can
use images created from imaging scans of human body to practice
complicated procedures such as brain removal and reconstructive

surgery.
s Engineering - Software engineers often wuse multimedia in
simulations.

Multimedia Software

s Word processing tools like Microsoft Word, Presentation software like
MS-PowerPoint and MS-Paint etc.

% Graphic and Image Editing Tools like CorelDraw, Photoshop

% Sound Editing Tools like Sound recorder from Microsoft, Apple’s
QuickTime Player pro, Sonic Foundry’s Sound Forge for Windows,
Sound edit, Audacity

% OCR Software

% 3-D Modelling and Animation Tools, Painting and Drawing Tools like

Freehand, Designer and Canvas.

Popular Software Tools for Multimedia

We can create, edit or run a multimedia content using the specialized
software like Windows Media Player, digital audio editors and VLC Media
Players etc. Let us discuss the working procedure of Windows Media
Player.

Windows Media Player

The Windows Media Player (WMP) is a tool (Software) that is used for
viewing photos, play music, and watch video. It comes with Windows
Operating Systems for free. It supports most of the image, audio and video
file formats like MPEG (Moving Picture Experts Group), MP3(MPEG Audio Layer 3),
MP4(MPEG Layer 4), WMA(Windows Media Audio), WMF (Windows Meta File), WAV
(Waveform Audio file format) AVI (Audio Video Interleave), DAT(Digital Audio Tape) etc.

It can play a song or Video files directly from CD or the hard disk. The
steps to be followed to play the relevant file in WMP are as follows.
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Step 1: Type “Windows Media Player” in the Search box and then double click
on Windows Media Player.

Step 2: Alternatively it can also be started by right clicking on Start->
Run-> type “wmplayer.exe” and click on OK

Step 3: Third method of opening Windows Media Player is to click on

Start>All Apps>Windows Accessories2>Windows Media
Player. It displays the following screen.
Windows Media Player — O >
I.;:/ll\:/l b Library » Music » Genre P Play Burn Sync
3 EI: - |55_Tf-:3' p vl ':E' H Save list '
Genre Count Length
&) Library Unsaved list
[k Playlists b
v I Music
0, Artist
There are no items in your Music
=) Album i
ibrary.
) Genre Click Organize, and then click & Unsaved list 4
& Videos Manage libraries to include folders
=] Pictures in your library.
Drag items here
[ Other Libraries D iterns
LE ) | |.@,| | » — =

Step 4: The library at the left side displays the different categories of
files like Music, Videos and Pictures. Select a category so
that the details pane at the right side displays all the files
available in that category.

Step S:Double click on any file to begin playing it. The seek slide can
be used to move forward or backward.

Computer Games

The multimedia computers support for various computer games.
Students can develop cognitive skills by playing the games. Some of
the games for cognitive skill developments are CogniFit-Brain
Training, FunExpected Math, Brain Kids, Solitaire, Chess, Knight
Riders, Free Cell, Minesweeper, Pinball, Road Rash etc.
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https://www.educationalappstore.com/app/brain-kids

EXERCISE

a.Name the following using the given hints

Sound Card / Windows Media Player / Multimedia System /
Microphone / TV Tuner Card

1. The computer system capable of processing, storing and
manipulation of multimedia content.

2. An input device to record your voice.

3. The piece of hardware to which the loudspeakers or headphone must
be connected.

4. The piece of hardware you will need to see television programs on
your computer's monitor.

5. The Windows software to play back sound.

b.Fill in the blanks

1. Multimedia is a combination of
a. Graphics, colours, sounds and animation b. 1's and O's
b. Input, process and output d. Bits and bytes

2. Multimedia can be used in
a. Schools b. Advertising c. Training d. All of these

3. In which of the following movies, multimedia's special effect is used?
a. Avatar b. Jurassic park c. Lion king d. All of these

4. Which of the following is an input device mainly used for gaming?
a. Keyboard b. Mouse c. Joystick d. Microphone

5. Which of the following is the popular graphic and image editing tool?
a. MS-Word b.MS-Paintc. Photoshop d. PowerPoint

C.Answer the following

1. Define - Multimedia.
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. Write down any 4 fields where Multimedia is used?

. Write a short note on Windows Media Player?

. Write down the Hardware requirements of Multimedia.

. Write down the Software requirements of Multimedia.

. Write the full form of the following.
MPEG :

MP3

MP4

WMF

AVI
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CHAPTER 4

Internet

Introduction to Internet
Hello my dear students!

Shall we go to the virtual world? Have you seen the film Avatar 2 (The
Water World)? Do you know that such a place does not exist on Earth? It is
fully the product of the director James Cameron’s imagination. We can see
many things on the Internet, but they are not available on our computer
because they are present on different web servers. Yes, the web content
looks like virtual on our computer. The Internet allows you to connect to
the world through computers.

Internet is also called as Net. In simple words, internet is a gigantic
collection of interconnected computers to share the information. It
connects millions of computers across the world.

History of Internet

In 1969, the first network, ARPANET (Advanced Research Projects Agency
Network), was created by the Department of Defence, USA, for the
exchange of information in the military. Later, it was used to connect
computers at different universities, and then it was demonstrated to the
general public.

The modern internet was developed by Bob Kahn and Vint Cerf in the year
1970 as a result of ARPANET project.

In the year 1989, Tim Berners Lee invented World Wide Web (WWW)
technology for the internet. By the end of 1990, the concept of Web page
was introduced. He also wrote the first version of HTML in 1993. In April
1993, the World Wide Web technology was available for the public use on a
royalty-free basis. In 1995 the first connection was established over what is
today known as the Internet. Since then, the Web has changed the world. It
is the most powerful communication medium the world has ever known.
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Uses of Internet

Internet connects millions of computers, people and websites. It has got
enormous applications in day to day life. Some of them are listed here.
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Send/Receive e-mail messages
Exchange of files between computers
Online education

Participate in groups discussions
Browsing the web

Online Chat

Video-conferencing

E-Commerce

Social Networking
Entertainments

Gaming

Requirements for using Internet

In order to work with Internet, we need to have the following

hardware /software
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0.0 0'0

7
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A computer/laptop or other devices like tablet, smart phone etc.

A telephone line or the cable connection that provides net connection.
A modem - It stands for modulator or demodulator. It helps to
connect to the internet over the telephone lines/cables.

An internet connection — It is provided by various companies called as
Internet Service Provider (ISP). Some of the service providers are
BSNL, Jio, Airtel, Tata, Vodafone etc.

Web browser — A software used to browse the web pages. The popular
web browsers are Google Chrome, Mozilla Firefox, Microsoft Edge etc.

Internet Terminologies

World Wide Web

The World Wide Web (WWW) is an internet based service for accessing

information over the medium of the internet using a common set of rules

known as protocols. It can also be defined as the world-wide collection of

electronic documents.
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Web browsers

A web browser is software that is wuseful for @ ? @,,.
accessing websites through the internet. The
information is transferred using http protocol. Some

of the popular web browsers are as follows Chrome, Opera, edge etc

Apple Opera
Safari

Web page

An HTML document or page available on the Internet is called a web page.
It generally contains text, graphics, images, and video.

Website

A website is a collection of web pages for a particular purpose. The first
page of the website is called the home page, which provides links to various
other pages. Website is owned and updated by an individual, company, or
an organization eg. www.aees.gov.in, www.cbse.gov.in

Uniform Resource Locator (URL)

It is an address for the resource available on the internet. It is simply the
web address that informs the web browser to search for the web content
and display it.

Search Engines

A search engine is software used to extract information from the internet
based on keywords or topics. Some of the search engines are Google, Bing,
Webcrawler, Ask, Yahoo!, MyWebSearch, Info.com, etc.

Google Aol.

@ | [ YAHOO / mywebsearch info.czrr.

Net (web) surfing

Exploring the web is known as web surfing or browsing, which is moving
from page to page on the Web. We can navigate through the links provided
on the web pages.

Steps to visit any website

Double-click on the web browser on the desktop to open it. The opening of
the website can also be done in the following ways:

% Click on Start button
% Click on All programs
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http://www.aees.gov.in/

% Click on a web browser such as Internet Explorer, Google Chrome
etc.
% Type the website address in the address bar or if you don’t know the
website address find it using the search engine.
% For example, type the website
addresshttps://cbseacademic.nic.in/ /index.html in the address bar.
o Press Enter key on the keyboard.
o The website opens as shown below,

f?larsl forem e -

B .
3 Azadik,

CENTRAL BOARD OF SEC'O D J A”’”‘Mahotsav?

250 aixl

(An Autonomous Organisa
‘Shiksha Sadan’, 17, Rou

Circulars v Publications v Curriculum v Training Portal Sahodaya Media Gallery Handbooks Heritage Education

Sample Question Paper v Question Bank v Results Skill Education Sports SAFAL v AI Life Skills SQAA FLN Corner

CBSE Reading Mission v CBE Resources Disclosure v Knowledge & Skill SIC HPC HolL CENBOSEC v ContactUs

':;E) Introduction to
N S
Foundational Literacy & Numeracy
Critical Competencies for FLN across Grade 1, 2& 3

Skills and Mindsets of an FLN Teacher

Active Pedagogy and Conducive Classrooms

o —
R 4 »
% ” " Importance of Assessments and Teaching Learning Materials To Know More
| W ‘S Click Here
- Available on Diksha & Google Classrooms E N

Announcemeints, Circulars & Notifications

I Academic “ Training S50 l Skill Education |

AT Sensitization Programme on Financial Literacy and use of Digital Tools

Then you can open the different web links available in the website to get
the desired information.

Exploring the Websites - AEES website

Atomic Energy Education Society website provides information about the
AEES schools. To open AEES website type website address www.aees.gov.in
in the address bar of the web browser. The website opens as shown below
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Candidates can login now to view their CBT Re

Click on the different tabs to get more details. Similarly you can open
different website and explore the information.
Example:

» https://ncert.nic.in

> https://www.education.gov.in

> https://www.navodaya.gov.in
> https://kvsangathan.nic.in
> https://www.wikipedia.org

Open your school website and explore all the pages.

EXERCISE
1. Fill in the blanks.

1. ARPANET stands for

2. Network of Networks is called

3. is a collection of webpages.
4. The full form of URL is

5. WWW Stand for

6. The World Wide Web was invented by

7. A is asoftware that is useful for accessing

websites through the internet.

8. The full form of ISP is
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https://ncert.nic.in/
https://www.education.gov.in/
https://www.navodaya.gov.in/
https://kvsangathan.nic.in/
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9. Exploring web is known as

10. WWW uses common set of rules known as

2. State whether the following statements are true or false.

Google is an operating system. (True / False)
Internet is a software. (True / False)
Web server contains the websites.(True / False)

Internet Explorer is a web browser.(True / False)

a kb=

Windows is also a web browser.(True / False)

3. Answer the following

1. Mention a few uses of Internet.

2. What are the devices used for the Internet connection?

3. Define World Wide Web.

4. What is Uniform Resource Locator?

5. What is Net Surfing?
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CHAPTER 5
Excel Spreadsheet — Part-1

Introduction

Microsoft Excel is a spreadsheet application mainly used to deal with data.
It allows organizing data in the form of rows and columns for data
manipulations, calculations, reports, charts, graphs, etc. MS-Word and
MS-Excel have a lot of common features as they are components of
Microsoft Office. As you are familiar with MS-Word, you can use several
common features of MS-Excel easily.

You can save the Excel file with .xlsor .xlsx extension.

Quick Access toolbar Title bar
File Tab

Data Add-ns

Review View

‘—‘1 & Calibn . u. - o i General . /\J S tnsen - E . ‘.}( t}l
~ D B I il Ax EES $*% - I Detete + [g+ #

Paste . 35 styltes Sont & Find &
Y J &= * B - A T =E P B 3 =i Format = | 2~ Firer~ Select+
) A \ ) v .

Celty Editing

g €—Column bar
9
10
11
12

13 =
W 4% »| Sheetl Sheat2 Thee:_'«! 2 [l {
Ready | )

Sheet Area
Status bar View Buttons

Zoom Controls

Starting MS Excel

MS Excel can be opened by double clicking on the Excel icon from the
desktop or task bar. Alternatively, select by clicking Start->All Programs >
Microsoft Office > Microsoft Excel, and then a new empty workbook will be
displayed on your screen. If you double-click on an existing Excel file,it
opens the Excel and displays the selected file on your screen.
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Closing MS-Excel

Excel can be closed by clicking the button X on the right side of the title
bar or by selecting File > Exit. If you have unsaved data, you will be
prompted to save the changes before exiting.

Benefits of Excel

MS Excel is widely used to store, analyse, and prepare reports on large
amounts of data. Excel is mainly used for calculations, accounting,
financial analysis, graphs, charts, etc. Some of the benefits of using Excel
are outlined below.

Easy to manage data like storing, retrieving, recovering etc.

Data can be organized at one place

Supports for mathematical and other functions to simplify
calculations

Presentation of data in the form of tables, charts, diagrams etc for
easy understanding

Quick analysis of data using pivot tables

Data can be secured using various protection mechanisms

7 7 K/
0.0 0‘0 0‘0

7
0.0

K/ 7
0'0 0.0

Basics of Excel

A workbook is a spreadsheet file that can contain up to 256 worksheets,
and each worksheet can have a maximum of 16384 columns and 1048676
TOWS.

What is a cell?

A rectangular box at the intersection of rows and
columns is called a cell. It is a basic unit in which
data can be entered. The maximum width of the cell is
255 characters, and it can store up to 32767 / el
characters. The current cell that has focus is called an [ 1
active cell, and it is identified by the dark border as

given in the picture.

Whatis Cell Address?

e T A cell address is identified by the column label and the row
number. For example, the cell address DS is determined by

row 5 and column D.
| —1

IR R RN SR

Page 36 of 67




Workbook

Insert..,

Delete

A workbook is a collection of worksheets. rename
When a new Excel file is created, a new Move or Copy...

workbook opens with three default & wiew Code
worksheets named Sheetl, Sheet2 and e TE'ztECtIS“EEt"' X
Sheet3.Worksheets can be inserted, o
renamed, copied, deleted, or protected by -
choosing the option when right-clicking the Select All Sheets

b M| Sheetl . Sheet2 | Sheets
sheets.
Worksheet

A worksheet or sheet is a collection of cells in the form of rows and
columns. Worksheets are used to store, manipulate, and display data.

Features of Excel

The various features of MS Excel are given in the form of menus and
options.

H T EH - O x
HORE IMNSERT PAGE LAY OUT FORMULAS REWIEW [RECY P W B Sign in
-Tﬁ X Calibri -l - = % FZ Conditional Formatting - i # E!‘
-~ B I U~ A & FZ7 Farmat as Table - =
Paste a- B — A Alighrnent Murmber < nrnst as fable Cells  Editing save
. ~ e Dy e A~ - - (9 cell Sthyles - - - Py
Clipboard Font Ta Stwles Save s o~
o1 - j; w
A =} C ] E F &) H ] -
]
|
2
3
4
3
B -
Sheet1 Sheet2 Sheet3 ) [ 3
EH M -—a—+ 100%

Home

It contains the options for editing contents, formatting options like font
size, font styles, font colour, background colour, alignment, insertion and
deletion of cells, sorting, filtering etc.

Insert

This menu helps to insert images, charts, shapes, clipart, math equations,
header, footer and symbols etc.

Page 37 of 67




Page Layout
Themes, orientation and page setup options are available under the page
layout option.

Formulas
Since MS Excel helps create worksheets with large amounts of data, the
Formulas option helps include formulas to get quicker solutions.

View

The display of the worksheet on the screen can be changed using the
different view options available in this menu. It also provides zoom options
to increase or decrease the zoom level of the document. You can use the
zoom controls available on the status bar to quickly zoom the document.

Data types

Microsoft Excel supports various types of data to be keyed into the cells.
The user can choose the type of data depending on the requirements. Some
of the commonly used data types are given below.

Number: It consists of digits that could be used to represent integers,
prices, percentages, and other numeric formats. Some of the number
formats include commas, decimal points, currency symbols, etc.If you want
to treat a number as text, then you should precede the number with a single
quotation mark (‘).

Text: It represents alpha-numeric information that includes names, places,
descriptions, sentences, headings, etc.

Dates and Times: It represents data in the form of date, time or both.
Calculations can be performed on date format to find the age, number of
days between two dates, etc.

Logical: It represents the Boolean values either TRUE or FALSE.

Error: It occurs when Excel recognizes the data entered or calculated is
wrong. It is identified by the symbol # at the beginning of the value like
#Name?, #Refl, #Num!, etc.

Working with Data in Excel

Entering Data in Spreadsheet

The following method is used to enter the data in a cell
% Select the cell by clicking the left button on mouse and it becomes the
active cell
% Type the new data.
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% Use TAB key to move to the next column or ENTER key to move to the
next row. Press ESC key to cancel the entry in the current cell before
leaving the cell.

% Click on formula bar to make changes in the formula and Press enter.

% To edit data in a particular cell, double click on the cell to place the
insertion point in it and make the necessary changes and press enter.

Note: Date should be entered using / or — sign like 25/08/2003 or 14-11-
2004, similarly time can be entered using : sign like 01:34:20

Deleting Data in Spreadsheet

The data in one or more cells can be deleted as follows
% Select the cell(s) to be deleted
% Press Delete key on the keyboard
% It deletes only the content not the cells.

Copying Data in Spreadsheet

The data in one or more cells can be copied as follows
% Select the cell(s) to be copied
% Right click on the selected cells and select Copy
% Point to the destination cell, right click and choose Paste
% You can also use the keyboard shortcuts Ctrl+C and Ctrl+V for copy
and paste operations.

Moving Data in Spreadsheet

The data in one or more cells can be moved as follows
% Select the cell(s) to be moved
% Right click on the selected cells and select Cut
% Point to the destination cell, right click and choose Paste
% You can also use the keyboard shortcuts Ctrl+X and Ctrl+V for copy
and paste operations.

Saving a Workbook

In order to keep your data permanently on the storage devices, you need to
save the file. The steps to be followed to save a file are as follows.

Click on File>Save, or click the Save icon

If this workbook has been saved before, then the workbook will be

saved again with the same name and location.

If it’s the first time of saving this workbook, then the Save As

dialogue box will open.

% Click the drop-down arrow next to Save In to select the desired drive
and folder.

* Type the new file name in the File name field.

K/ 7
0‘0 0‘0

)
L X4
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% The default file type is Excel Work Book. Excel file can also be saved
in different file formats.
% Click the Save button.

< The extension for the Excel file will be .xls or .xlsx

Formatting

The formatting feature of Excel helps to present the worksheet in an
attractive manner. It changes the appearance of the data present in the
worksheet without modifying the actual data. With the help of the format

cells, we can change the number, alignment, font style, border style, fill
options, protection, etc.

First, select the range of cells to which you want to apply the formatting
feature and right-click on the mouse to access the formatting option. It
displays a pop-up menu, and then we have to click on the Format Cells, or
we can also use the shortcut key Ctrl+1 on our keyboard.

16 =art g
17 D Get Data frem Table/Range...
18
19 t:' Insert Comment
20 I Format Cells... I
21
22 Pick From Drop-down List...
B — . Define Mame... i
Sheetl ()
— 2 Link

Readwv

The below picture shows the various tabs present in the Format Cells

dialogue box. Most of the following options can also be accessed from the

Home tab of the menu bar.

Format Cells

Alignment Font Border Fill Protection I
Category:
Number Ssample Format Cells
Tab Alignment Font Bo
3 . . Category:
It is used to apply the formatting options for number Sample

MNumber

cells, offering the appropriate format in terms of | fnone, comerat form
Date

number, date, percentage, fractions, and so on.We can Time
ercentage

also apply other formatting options such as currency, | e
date, time, percentage, etc. Specia
Custom
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Alignment Tab

The alignment tab can be used to
align the data in the cell and
merge the text of two cells
together. If the text is hidden, we

[ shrink to 1it

can use the wrap text to display it | ...

Text direction:

appropriately, and align the text in I = =
the desired direction.

Text Alignment option allows to align the text within the cells both
horizontally and vertically.

Font Tab

Font Tab helps to alter the font size, font style, font color, etc. We can
change the font effects, underline the text, and it can also be previewed.

Quick Font changes can be made from the home tab; however, the Format
Cells dialog box is more efficient for mass changes. From there, we can
easily modify the typeface, font size, italicize, point size, bold underlining,
italicize, and, color across the whole selection of cells.

Format Cells ? ®

Mumber  Alignment Barder Fill Protection

Font: Font style: Size:

Calibri Regular 11

Calibri Light (Headings ~ | CETE 8 ~
d Italic 9

Agency FB Eald 10

Algerian Bold Italic

Arial 12

Arial Black v 14 W

Underline: Colon

Nane ~| I - []Normal font

Effects Freview

Border Tab

By using the Border Tab, we can create different colourful border lines for
one or more cells; if we don't want to provide the border outline, we can
leave it blank. We can choose the thickness, colour, style and the sides of
the lines.

Format Cells 4 >

Mumber Alilgnment Font Fill Protection

Lines Presets

Color:
Automatic —

The selected baoarder style can be applied by clicking the presets, preview diagram or the buttons
abowe.
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EXERCISE

1. Choose the correct answer.
2. The address that is obtained by the combination of the Row number
and the Column alphabet is called

a. worksheet b. cell c. workbox d. cell address
3. Excel workbook is a collection of and
a. worksheet and charts b. graphs and images
c. sheets and images d. video and audio
4. is used to display the worksheets attractive and legible manner.
a. Editing b. Formatting c. Polishing d. None of these

S. In Excel, by default the sheets tabs colour is,

a. black b. white c. yellow d. Red
6. Text, Number, Dates and Times are some of Excel.
a. Functions b. Data types c. Formulas d. None of these

2. State True or False.
1. We can apply different colours in the same cell.
2. Using MS-Excel we can draw paintings.

3. Basic file operations such as creating, deleting, renaming, editing etc.
are same for both MS-Word and MS-Excel.

4. A worksheet in excel is automatically created whenever we open MS-
Excel.

5. When we open a new Excel sheet the active cell address is Al.

3. Fill in the blanks

1 .A workbook can contain a maximum of worksheets.

2. data type in Excel sheet represents the values either True or

False.

3.The maximum width of the cell is characters long.

4. in Excel helps to get quicker solutions.

5. key is used to move the cursor to next cell in Excel.
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4. Answer the following

1. What are the benefits of Excel?

2. What is a cell address?

3. Write about any three data types.

4. What do you mean by formatting?

5. Practice the following on your computer.

1. Create the following worksheet in excel

R.No. Name of the student Date of Birth Class House | Uniqueld
1 KAVIN 12-02-2015 IV-A RED 1101102
2 HARISH 02-07-2014 IV-B BLUE 1101201
3 NAVEEN 14-11-2014 IV-C GREEN 1101301
4 RAJESH 25-08-2015 IV-D YELLOW | 1101401

a. Apply the formatting features such as alignment, bold, colour, font etc.
b. Try the different formats of date data type for the field Date of Birth.
c. Rename the sheet to Students.

d. Copy the first row and paste it at Sth row.
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. Change the data in 5t row.

Using the formatting tab, try various options of Number, Alignment, and

Font etc.

. Insert 3 rows in between for new students and enter the data

. Save your file in a particular folder.

Again open the file, make changes in the data and save the file.

Page 44 of 67




CHAPTER 6

Excel Spreadsheet advance- Part-2

Formulas and functions

Formulas and functions are the basic building blocks for performing
arithmetic calculations in Excel.

A formula is a combination of cell addresses, functions, operators, etc. In
Excel, every formula must begin with an equal

. _ - K | =B2+B3
sign (=). : -
g ( ) | A& | @ c ¥ E

1

For example, assume that the cell B2 contains 2 5
3 ]

the value 5, B3 contains the value 6, and the s —=

cell B4 contains the formula =B2+B3 then the

result of 11 will be displayed.

12 - fe | =SUM(D2:H2)ome
A B c D N G H I J K

1 S.NO. NAME OF THE STUDENT |DOB EMNGLISH |HINDI MATHS RTENGE._&(_]C.SCI. TOTAL AVERAGE

2 1 HOVIYA NARASIMMAN | 25-08-2003 93 91 93 39 g -~ 468 93.60 ""I::|2J"r5

3 2 NETHRA MARASIMMAN | 14-11-2004 90 88 98 85 99 460 92.00

4 3 5 MUTHULAKSHMI 27-04-2003 85 34 99 85 90 443 88.60

Range

A group of cells in a worksheet is called a cell range. The range of cells are
identified by the anchor points like the cell address of top left and bottom
right corners separated by colon (:). For example the range of the cells
A1:B3 includes the cells A1, B1, A2, B2, A3 and B3.

Operators
A formula contains constants, cell | Operator Purpose
addresses and operators, etc. An * Addition
operator performs an operation using Subt.ragtlor'l
the operands. Though there are several Mu m.p lication

: ) / Division
operators in Excel, the following % Percentage
arithmetic operators are widely used for A Exponentiation (52)
calculations.
Functions
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A function is a ready-made formula for the more frequently used
mathematical or statistical operations. A function can be used with the
formula like =Function Name (arguements), where arguments can be
the address of the cells or a range of cells. Some of the commonly used
functions are given below

Function Purpose Example

SUM To find the sum of values present | =sum(al,a2,a3,a4)
in the cells =sum(al:b4)

AVERAGE To find the average of the values | =average(al,a2,a3)
present in the cells =average(al:a25)

ROUND Rounds the given number to the | =round(a2,1)
specified number of digits. g rounds to one decimal

1git.

MIN Returns the minimum value in the | =min(al:a25)
given range

MAX Returns the maximum value in the | =max(al:a25)
given range

COUNT Returns the count of the text or | =count(al:a25)
numbers

Auto Sum

AutoSum is a function used to calculate the result based on the function
selected. For example, if you want to add the values of cells A1 through AS5,
select the cells A1 through A5 and click the AutoSum button, it creates the
formula =SUM(A1:AS5) in cell A6 and displays the sum of those numbers.

A B c D E F G H I ) K
1 S.NO. |NAME OF THE STUDENT |DOB lEE_@L[@l—Iﬂ HINDI _ |MATHS _|SCIENCE | EQQ;SE';.‘ TOTAL | AVERAGE

2 1 |HOVIYA NARASIMMAN 25-os-zouarugg”””glnaHﬂs_g”""gg"”"gguj =suM(PRIE) | 93.50

3 2 |NETHRA NARASIMMAN |14-11-2004| 90 88 98 85 g9 | [SUMmumbert, [number2] ] |
4 3 |S MUTHULAKSHMI 27-04-2003| 85 84 99 85 90 413 88.60

Note: AutoSum function has several other numerical = ”‘”t“”"‘q‘mﬁt«_’ I}
Z  Sum
- £

functions such as Average, Count Numbers, Max, Min

Average It
etc. The result of the function appears on the next or | Countnumeers |
bottom cell depending upon the direction of the cells |  ma i
selected. Min

More Fundtions...

Handling with rows and columns
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Inserting row(s) and column(s)
In order to insert the rows or columns, do the following steps

1. Select the row(s) or column(s) on the row number(s) or column label(s)

2. Right click on the selection portion and click on insert

3. The selected number of row(s) or column(s) will be inserted below the
row(s) or right of the column(s).

Deleting row(s) and column(s)
In order to delete the rows or columns, do the following steps

1. Select the row(s) or column(s) on the row number(s) or column label(s)

2. Right click on the selection portion and click on delete

3. The selected number of row(s) or column(s) will be deleted and the
row(s) or column(s) will be shifted accordingly.

Steps to insert cell(s)

In order to insert the cell(s), do the following steps

1. Select the cell(s) where the new cell(s) to be |nst ? bt
inserted Insert
2. Right click on the selection portion and click on | OShiftcelsrignt

insert
3. Now a pop-up dialogue box will appear and Excel | O entire column
will ask you choose the option so that the selected

OK, Cancel
cell(s) will be shifted accordingly. .
Steps to delete cell(s)
In order to delete the cell(s), do the following steps Delete ? %
1. Select the cell(s) to be deleted DEZH:FE ....... -
2. Right click on the selection portion and click on Dsh:ﬁEZII:;
delete (") Entire row
3. Now a pop-up dialogue box will appear and Excel | ©FEntreclmn
will ask you choose the option so that the selected Cancel

cell(s) will be shifted accordingly.
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View Menu

()
—-/ Home Insert Page Layout Farmulas Data Review View
= Ruler ¥| Formula Bar e - |
EINEER EN = Q [ | 2 5 E
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Mormal| Page Page Break | Custom Full . N Zoom 1008 Zoom to Mew  Arrange Freeze
Layout  Preview Views Screen essage bar Selection || Window  All  Panes ™

Workbook Views - Show/Hide Zoom
Excel provides various features in View menu for display and print settings
of the workbook. It allows creating multiple views without saving each view
separately. Some of the important features of View menu are explained
below

Normal View: This is the default option in the Workbook Views. It shows
data in the form of rows and columns.

Page Break Preview: This view splits the worksheet into printable areas.
When you want to print part of the worksheet, you should use this view
option.

Page Layout: It displays the worksheet as it will be printed on a paper. It
helps to adjust the setting like margin, header, footer etc.
Gridlines

Gridlines are the light grey line that indicates the rows and columns.
Selecting the gridlines check box toggles the display of gridlines.

Freeze Panes

Freeze panes option is used to keep one or more rows or columns visible
while scrolling. It also allows to freeze first row or column and to scroll the
remaining part of the worksheet.

Zoom

Worksheet can be zoomed to a required level so that

the better clarity in reading can be achieved. I__bI g
m o

Zoom - Displays the "Zoom" dialog box and we can 7., 100% Zoom to

choose the % of zooming. Selection

100% - It displays the workbook to 100% of its normal
size.

Zoom

Zoom to Selection -It zoom the worksheet to display just the currently
selected cells.
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Inserting Images

An image can be inserted to a worksheet using the Insert menu as follows

= )
= Home Insert Page Layout Formulas Data Review View

o— o ﬂ.ﬂ] F_' i . - ]
1 ’ — ] u =
JJ| H | |nall @i _J) Zﬁ ﬁh ?}‘}f R ﬂ 'iJ
PivotTable Table Picture Clip Shapes SmartArt | Column  Line Pie Bar Area Scatter Other

- Art - - - - - - - Chartsv
Tables INustrations Charts [=

Steps to Insert Picture in a Cell

% Click on Insert>Pictures from the Illustrations group.

B

% An Insert Picture dialogue box will be opened. Choose the picture to
be inserted from your computer
» A latest version of MS-Excel also supports to insert picture from the

L)

online.
% Click on Insert, then the image will be inserted into the spread sheet.
% By selecting the inserted image, it can be resized as per the

requirement and be placed wherever required.

Inserting Charts

The graphical representation of data gives an easy way of analysing data.
The chart in Excel helps to visualize the data graphically. There are various
types of charts available in Excel like Column, Line, Pie, Bar, Area etc.

Steps to Insert Charts

% Select the data for which you need to create chart.

% Choose the appropriate chart by clicking on the chart icons available
from the Charts group of Insert Menu.

s By selecting the inserted chart, it can be resized as per the
requirement and be placed wherever required
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EXERCISES

1. Fill in the blanks with the correct answer by using the
given clue words.

Freeze Panes / View side by side /Synchronous Scrolling /worksheets /
Alphabet and Numbers

1.

N

. By default a workbook has three

is used to view two workbooks at a time on the

screen.
is used to scroll down two spreadsheets at a time.

is used to keep the first row or some selected rows
visible while scrolling down.

.In excel a cell is named with the combination of

2. State True or False.

1.
2.
3.

4.

5.

A formula begins with the sign $.
The colon (:) is used to specify the range of cells.
MAX function is used to find the maximum value in the range of cells.

Freeze panes option is used to keep one or more rows or columns
visible while scrolling.

The chart in Excel helps to draw pictures or painting.

3. Answer the following

1.

What do you mean by a formula in MS-Excel?

2. Name any four operators and its purpose?

3. Explain the purpose of the functions: SUM, ROUND, MAX
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4. Write the steps to insert rows in Excel?

5. Write any three different views of Excel Worksheets.

4. Practical Problem

1. Create a table in the sheetl of a new workbook using Microsoft excel.
Enter 10 Students mark details with the fields S.No.,R.No., Name, English
marks, Hindi marks, maths marks and EVS marks.

. Delete sheet2 and Sheet 3 from the workbook.

Rename sheetl as marks.

Insert a new column named class/sec after the Name column.
Change the width of the Name column as 25

Change the row width as 10 for all the rows

Save the excel file with the name “Marklist”

Open the workbook named “Marklist”

Freeze the first row. Save the file and close it.

XN RN

2. Create a sheet named “CCA Prize List” with the fields S.No.,R.No., Name
and No. of CCA prizes won in a new workbook for the same set of students
whose marks are entered in “Mark list” workbook. View the “Mark list”
workbook and “CCA Prize List” workbook side by side and scroll down

synchronous
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CHAPTER 7

Number Systems

Introduction to Number Systems

From the early days of human civilization, people used to count things
using their fingers, sticks or any other things. Later on, number of things
they count becomes more and more, so they found the inefficiency of that
system. They introduced a new system for counting based on the weighted
number system. The general number system used all over the world is
called decimal number system which has 10 different symbols and set of
weights ( 1, 10, 100, 1000 ....etc.).

The number system is the way to represent numbers or symbols in
computer system.This is also called as positional number system because
the value of the each symbol depends upon the position of the digits within
the number system.

Applications of the Number Systems

¢ Computer is a machine which works on the principles of mathematics
and physics. It simply stands for “to compute” so the computation
takes place on numbers.

¢ It represents the electronic states like ON or OFF

¢ Memory locations are identified, called address, using number
systems

¢ It helps in the design of computer languages.

Types of Number Systems

In mathematics you must have heard the number systems such as whole
numbers and real numbers. Let us see the four number systems which are
used in the design of computer architecture. They are

1. Decimal Number Systems

2. Binary Number Systems

3. Octal Number Systems

4. Hexa Decimal Number Systems
These number systems are explained below.
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Decimal number system

The Decimal number system is the most widely used number systems in
the world. It consists of ten digits ranging from O to 9 and it represents a
numeric value. The base of decimal number system is 10, because it has
only 10 digits.

The value of the each digit in a number is based on its weight and position
of the digits. The value of the position is increased by 10 times from right to
left order in the number.

For example, the value of 345 is
=3x102+4x 10! +5x 109
= 300 + 40 + 5= 345

Binary Number System

The computer is made up of digital circuits, hence the data or information
must be represented using binary number system in the form of O and 1 as
these digits represents ‘on’ and ‘off’ state of the electronic switch. The
combination of 1 and O forms a binary number. It is called as binary
number system because it uses only two digits, hence the base of the
number system is 2.

The binary number system uses positional value and each digit ismultiplied
by the appropriate powers of two based on its position.

For example, (1001)2 in decimal is
=1x23+0x22+0x21+1x20
=1x8+0x4+0x2+1x1
=8+0+0+1

= (910

Octal number system

The term Octa means 8, so the octal number system has the base of 8 and
the symbols are from O to 7. The positional value plays an important role in
expressing the numbers. Each digit is multiplied by the appropriate powers
of eight based on its position. An Octal digit is represented by 3 bits in
binary number system (i.e. 23 =8)

For example, (63)s in decimal is

= 6x81+3x80
=48 +3 = (51)10
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Hexadecimal number system

It is the combination of decimal number systems, such as 10 digits (O to 9),
and an additional six (hexa) symbols such as A, B, C, D, E & F. The base of
the hexadecimal number system is 16, because it has 16 alphanumeric
values. Each digit ismultiplied by the appropriate powers of sixteen based
on its position. An octal digit is represented by 4 bits in binary number
system (i.e. 24 =16)

The summary of various number systems with its base (radix) and symbols
are as follows

S.No | Number System | Base/Radix Symbols used
1. | Binary 2 Oand 1
2. | Decimal 10 0,1,2,3,4,5,6,7,8,9
3. | Octal 8 0,1,2,3,4,5,6,7
4. | Hexa decimal 16 0,1,2,3,4,5,6,7,8,9, A,B,C,D,E,F

Binary number system

It consists of only two digits such as O and 1 for representing any symbols
in the computer. A computer consists of electronic circuits, which can exist
only in one of the two states either ON or OFF. So to represent the state
ON, the digit 1 is used, and to represent OFF state, the digit O is used.
With these digits computer can easily manipulate numbers stored in
memory for addition, subtraction, multiplication and division operations.
The binary number system works like the decimal number system, but
uses base 2 and the symbols are O and 1.

The weighted values for the position of binary number system are as
follows

25 24 23 22 21 20 2-1 22 23
32 16 8 4 2 1 0.5 | 0.25 ] 0.125

Page 54 of 67




Different formats of binary number system

The sequence of bits in binary number system can be defined as
boundaries. They are as follows

Unit name Size Example
(bits)
Bit 1 Oor 1l
Nibble 4 1010
Byte 8 0001 1010
Word 16 1010 0001 1010 1010
Double word 32 Group of 32 bits

BIT:A bit is the smallest unit of data on a binary computer, which takes
either O or 1.

NIBBLE: A nibble is a collection of 4 bits. It is used in BCD (Binary Coded
Decimal) and hexa decimal systems. We can represent up to 16 distinct
values. Format: bsbz2bibo (24 =16)

BYTE: It is a group of 8 bits or set of 2 nibbles. A byte can be represented
as follows

b7bebsbabsbsbibo
High order bit \ﬁow order bit

A byte can identify up to 256 (28 = 256) distinct values or symbols.

WORD:A word is a group of 16 bits or 32 bits depends upon the processor
of the computer system.

Binary Arithmetic

Like decimal number system, we can perform all arithmetic operations
such as addition, subtraction, multiplication and division on binary
number system also. Since the binary number system deals with only two
digits i.e. O and 1, the result of arithmetic operation also will be in the form
of O’s and 1’s.

Binary Addition

The following truth table summarizes the addition of any two binary digits

A B A+B
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0 0 0
0 1 1 (1+1 is not 2, since binary uses only two symbols
1 0 such as 0 and 1. It is similar to 9+1=10 in decimal
1 1 10 number system. Note: addition of 1+1+1 is 11,
1+1+1+1=100, 1+1+1+1+1=101 etc.)
Eg. Add binary numbers | Add binary numbers 11+101
1011012 + 1011112
Carry----> 11
Carry----> 11111 .
First number----> 11
First number----> 101101
Second number-> 101
Second number-> 101111
Result------------ > 1000
Result------------ > 1011100
112+1012= 10002
1011012 + 1011112 = 10111002

Binary Subtraction

The following table summarizes the subtraction of any two binary digits

A-B

column)

O~ O|»
—|Ol~OlW

== OO

(0-1= 1 only if borrow exists in the next higher

1011012 - 11112

First number----> 101101
Second number-> 1111
Result------------ > 11110

1011012- 11112 =111102

Eg. Subtract two binary numbers

Subtract binary numbers

105-012
First number----> 10
Second number-> 01
Result------------ > 01
105-012 =015

Note: To verify the result, add the result and the second number to get the

first number.
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EXERCISE

1. Choose the correct answer.

1. Which of the following is not an electronic state(s)
a.ON b. OFF c. Both (a) and (b) d.Button

2. Which of the following is not a number system?
a. Binary b. Real c. Octal d. Decimal

3. The radix of an octal number system is
a. 8 b.16 c.2 d.10

4. The value of 2-1 is

a. 2 b.1 c. 0.5 d.-1
S. A byte is a group of bits
a. 8 b.16 c.4 d. 32

2. State True or False.
1. In binary number system 12+12 = 25.
2. A bit is a group of 4 bits.
3. The octal number system uses the symbols O to 7.
4. The base of the binary number system is 2.

5. A word is equivalent to a byte.

3. Answer the following

1. What are the applications of the number systems?

2. Name the four types of number systems with its base.
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. Define binary number systems.

. Name memory units with its storage space?

. Write the truth table of binary addition and subtraction?

. Do the following binary arithmetic operations?
a. 10112+101»= 2 b. 1000102+ 11112- 2
c. 101012- 1001»,= 2 d. 10102- 1012= 2
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CHAPTER 8

Programming with Logo — Part-2

Introduction

You have already learnt in your previous class about
the basics and commands of Logo (Part-1). In this

X
to

45° 90°

lesson, we shall learn the advanced commands and procedures of Logo. Let
us revise the commands discussed in the previous class.

Command Description Example
FORWARD/FD n It moves the turtle n units forward FD 100
BACK/BK n It moves the turtle n units backward BK 50
RIGHT d It turns the turtle clockwise n degrees RT 90
LEFT n It turns the turtle counter LT 45

clockwisendegrees.
PENUP/PU Turtle's pen moves without drawing i.e., | PU
pen is up.
PENDOWN/PD Turtle's pen is in the down position. PD
PENERASE / PE Turtle erases as it moves. PE
HIDETURTLE /HT Removes the symbol 'triangle' of turtle |HT
from the screen.
SHOWTURTLE/ ST Makes the Turtle visible again. ST
CLEARSCREEN/ CS |Erases the screen and returns the CS
Turtle to the centre of the drawing
screen.
HOME Returns the Turtle to the "home" HOME

position without erasing the screen. You
can use PU to move without drawing.

LABEL [Text] /

LABEL “ Text”

Displays text at the Turtle location. The
Text using double quotes displays the
text with double quotes and the text
given in index brackets ([ ]) displays
without quotes.

LABEL [Hello]

SETPENCOLOR 1-15 |It sets pen colour SETPC 4
Red - 4, Green - 2, Blue - 1 etc. for Redcolor
SOUND [mn] It creates sound with the frequency of SOUND [100
m for n milliseconds 1000]
SETPENSIZE [m n] Sets width and height of the drawing SETPENSIZE
pen to the values m and n respectively |[5 5]
SETXY(x,y) It positions the turtle at the coordinates | SETXY(60,60)
x (X-Axis) and y (Y-Axis)
BYE Exits Logo
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Let us discuss some of the important logo commands with example.

REPEAT command

This command is used to repeat the statements for the given number of
times. A repeat command within another repeatis called nested repeat
command. The format of the command is

REPEAT n [ Commands]

Here n stands for the number of times to be repeated and Commands are
any valid Logo commands to be repeated.

Example-1:

Draw a rectangle using REPEAT command.

Rectangle without repeat command | Rectangle with repeat command
fd90 The output of the given | REPEAT 4 [ FD 90 RT 90]

rt 90 commands is
fd90 The output of the command is
rt 90
fd90
rt 90
fd9o P NE—
rt 90 A

Here both the commands display the same output but the second method
simplifies the coding.

/\ Consider the following diagram to

understand the use of nested repeat

Example-2:

command.

The command to create the given

\)\
diagram is
repeat 8 [repeat 4[fd 100 rt 90] rt 45]

\/ The command repeat 4[fd 100 rt

90|creates a rectangle and this is
repeated for 8 times with an angle of 45 to get the desired output.

Try the above command with different values to observe the different

patterns.
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Procedures

A procedure in Logo helps to place a set of commands together so that they
can be executed sequentially. The procedure can be created with or without
arguments. The three parts of a procedure are as follows

TITLE: It specifies the name of the procedure.

BODY: is a set of commands that will be executed when we execute
the procedure by name.
END : This tells logo that the procedure has come to an end.

The general format of the procedure is as follows

To procedurename
body
end
Here to& end are the keywords that states the beginning and end of the

procedure.Body contains the valid logo commands or statements.

The comments or remarks can be included in the procedure by prefixing
semicolon (;). It is only for understanding purpose and will not be executed
by the logo software.

Example 1: Create a procedure to draw a triangle.
Steps:

1. The editor for creating the procedure can be opened in two ways
such as EDIT “name of the procedure or using Edall.

edit "triangls | Execute | Edal \‘
2. The editor window opens with to
. File Edit Search Set Test! Help
name&end and the required commands te trisngle
can be inserted in the body of the
procedure.

3. Type the following command in the body of the procedure
REPEAT 3[FD 60 RT 120]

4. Save the file by clicking File>Save and Exit
5. Now the procedure is ready to use. Execute the procedure triangle
from the command window.e.g. TRIANGLE and press execute.

Operations on Procedures
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Saving a procedure
To save a procedure, follow the steps,

» Click on File>Save from the main menu of Logo
» The Save As dialog box is displayed.
» Type a filename in the file name box and click Save.

Loading a procedure

The saved procedure can be loaded in the computer memory and used
again. To load the procedure file, follow the steps-

» Select File>Load

» The open dialog appears

» Click the file name in the file list and click Open.

» The procedure file is loaded into the computer memory. We can
type the procedure name to execute it.

Editing a procedure file
To edit procedure file, follow the steps-

» Open the procedure using the steps given in Loading a procedure

» Click on Edall button from the editor window. The saved
procedures will be displayed.

» We can edit the procedure now and then save it.

Example 2:

Create the following picture using procedure

The procedure for the above diagram is as follows

TO PICTURE
REPEAT 6 [REPEAT 3 [FD 60 RT 120] RT 60]
END

To run the procedure, type PICTURE in command window and press enter.

Logo Programming
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Logo was the one of the oldest programming language. It is a student
friendly language so that they can learn it easily. Some of the basic
elements of programming are given below

1. Variables

A variable is the name assigned to the memory location to store a
value. Rules for framing a variable are as follows

Can have letters, numbers or symbols.

Always begin with a letter.

Cannot use Logo commands like Left, PU etc.
Cannot have blank spaces.

Cannot have mathematical signs such as +,-,* and /.

L

The variables can be created using the command make as follows
make “variable value

Variable can be a valid logo variable name and the value should be
appropriate to the variable. A string value can be prefixed with double
quote ().

Examples:

. make “a 100

. make “eng mark 95

. make “student name “Nethu
. make “address “Tarapur

A ODN R

Note: The variables can be accessed by prefixing the colon with the
variables like :a, :end mark, :student name, :address etc.

2. Print Primitives

The print or pr primitive in logo is used to print the text or number on the
screen. The different formats of print command is as follows

1. PRINT “Text - it prints the given text

2. PRINT :a - it prints the value of the variable a

3. PRINT [Writing program in Logo is a fun] — The text given within the
index brackets ( [ ] ) will print the text as it is i.e., the output will be

Writing program in Logo is a fun. This format is used to print
multiple words in the text with blank spaces.
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3. Arithmetic operators

The simple arithmetic operations can be performed using the arithmetic
operators. It produces a numerical result. The various arithmetic operators
used for arithmetic operations are as follows.

Operator | Purpose Example
+ Addition atb+c, markl+mark?2
Subtraction a-b, gross-ded
Multiplication a*b, hours * rate
/ Division c/d, total/4
Example 1:

Write a procedure to find the sum and difference of two numbers

The logo program is The output is
to sum diff sum
make "a 100 300
make "b 200 Difference
make "sum :a + :b -100

make "diff :a - :b
print "sum

print :sum

print "Difference
print :diff

end

Example 2:

Write a procedure to find the area and circumference of a rectangle

The logo program is The output is
to area Area

make "a 10 200

make "b 20 Circumference
make "area :a * :b 60

make "cir 2 * (:a + :b)
print "Area

print :area

print "Circumference
print :cir

end
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Logo functions

The ready-made or built-in functions in logo arethe pre-written programs
which can be used directly for finding the result without writing any code
for the function. The following functions return the appropriate result
supplying the parameters.

S.No. Function Purpose Example | Result

1. sqrt n It returns the square root of | sqrt 9 3
the positive number n.

2. power m n | It calculates the power value | power 2 3 8
of m raised to n i.e., mn

3. abs n It returns the absolute value | abs -25 25
of n i.e. positive equivalent of
negative number.

4. int n It truncates the fractional |int 26.75 26
part of the number and
returns only integer part.

S. modulo m n | It returns the remainder of | modulo 8 3 2
the division m by n

6. random n It returns any random |random 25 23
number less than n

7. round n It rounds to the nearest|round 23.6 26
integer. round 12.1 12
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EXERCISE

1. Fill in the blanks.

—

. The Logo command to clear the screen is

2. Command is used to removes the symbol 'triangle

of turtle from the screen.

3. A repeat command within another repeat is called

repeat command.
4. The command to create a variable in Logo programming is

Command prints the result or texts on the screen.

2. State True or False.
1. The operator used for division is %.
2. The function sqrt 16 gives the result as 4.
3. SOUND [ m n | creates sound with the frequency of m for n milliseconds.
4. from and end are the keywords used to create the procedure in Logo.
5. A variable can begin with a number.

3. Answer the following

1. Write the syntax of repeat command with an example?

2. How will you include remarks/comments in a Logo procedure?

3. Write the steps to save a procedure in Logo.

4. What are the rules to create a variable?
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5. Write a short note on arithmetic operators.

6. Write the purpose of the library functions: sqrt, power, round

5. Try the following logo | to decagon
commands in MSW Logo repeat 10[fd 100 1t 360/10]

end
and draw the output.
to circlel OUTPUT:
repeat 36[fd 30 1t 360/36]
end
OUTPUT:
to triangle to shape3
repeat 3[fd 150 1t 120] repeat 100[triangle rt 30]
end end
OUTPUT: OUTPUT:

Write the logo procedure using | Write the Logo commands to
repeat to draw a rectangle. draw a house.
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